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TOPIC -----------------------------------------------------------

This article describes the new features and other improvements of MacX 1.2,
configured to broaden compatibility with X client applications and to
provide you with increased ease of use. You may even notice some
improvements in performance. In most cases, you'll never have to adjust the
MacX 1.2 default settings. Advanced users, however, may want to study the
following feature descriptions to see if their special needs might be met
by changing the default settings.

DISCUSSION ------------------------------------------------------

This section provides information about improvements and features not
described in the MacX 1.1.7 Release Notes or the MacX User's Guide:

• If your Macintosh computer has a color monitor and video card, MacX 1.2
  makes color graphics capabilities available to X client applications by
  default. No special "screen" designations are required. Advanced users,
  however, can change the screen designation to meet special needs.

• MacX 1.2 provides further display improvements with a special option
  preset to disable non-zero screens. With this option as the default, the
  server only recognizes screen 0. This is helpful for those clients that
  experience programmatic conflicts caused by the presence of multiple
  screens. Advanced users, however, can change this option to enable
  multiple screens.

• MacX 1.2 provides standard X Window System Backing Store and Save Under
  capabilities. With these features, graphics don't have to be redrawn
  every time an overlapping window or pop-up menu is moved or closed. Some
  X client applications rely on these capabilities to support complex
  graphical operations.
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• MacX 1.2 makes all 256 entries of each screen's default colormap
  available for use by X client applications. This treatment of screen
  colormaps represents a change in the default function of MacX 1.1.7.

• By default, MacX 1.2 disables the Smoother Animation feature in order to
  provide better graphics performance. This represents a change in the
  default setting from the MacX 1.1.7 setting.

• MacX 1.2 allows client applications to connect to your Macintosh computer
  without any action on your part. If you want to control which X client
  applications are displayed on your MacX server, you can enable Access
  Control from the MacX Remote menu. As a result, a host access alert box
  will be presented to you before an X client is allowed to be displayed on
  your screen. This treatment of host access alert boxes represents a
  change in the default setting from MacX 1.1.7.

• New window-menu commands give you more ways to manage windows. The
  Circulate Up and Circulate Down commands give you easy ways to switch
  between windows. The Maximum Height / Restore Height command gives you an
  easy way to resize windows.

• MacX 1.2 reports the size of a window as you resize it.

More Flexible Screen Configurations
-----------------------------------
MacX 1.2 provides greater compatibility for X client applications that are
unable to support more than one X server screen. This improvement is
especially useful for clients that only check the default screen for color
support. MacX now supports clients that expect color capability on the
default screen, also called screen zero, or the screen corresponding to the
display host:0.0.

The default settings for screen zero are as follows:

• Match Best Monitor.  If you have a color monitor connected to your
  Macintosh computer, the default screen is configured for color. If you
  don't have a color monitor, MacX displays the screen in black and white.
  If you have more than one monitor attached to your Macintosh, the MacX
  Window Manager places clients on the color monitor by default.

• Rootless Mode.  The default screen is a rootless screen that uses the
  MacX Window Manager to adorn client windows in the Macintosh style.

Advanced users can change the screen designation to meet special needs. To
change the default screen configuration, follow these steps:

1) Open the MacX application program by double-clicking its icon.

2) Choose the Display Preferences command from the Edit menu.

3) Click the Screen Zero options that correspond to the configuration you
   want.
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   Once you choose Screen Zero options, the attributes of the other MacX
   screens are established according to the following table.

   • Note - If you have the Disable Non-zero Screens option (the default
     setting) turned on, then only the screen 0 column has meaning.

MacX Screens - ("Monochrome/" is represented in the table as "Monochrm/")

Screen Zero options  Video card    Screen 0  Screen 1  Screen 2  Screen 3
-------------------  ----------    --------  --------  --------  --------
Match Best Monitor   8-bit/pixel   Color/    Color/    Monochrm/ Monochrm/
(Rootless)          (256 colors)   Rootless  Rooted    Rootless  Rooted
                     1-bit/pixel   Monochrm/ Monochrm/ Color/    Color/
                    (monochrome)   Rootless  Rooted    Rootless  Rooted

Match Best Monitor   8-bit/pixel   Color/    Color/    Monochrm/ Monochrm/
(Rooted)            (256 colors)   Rooted    Rootless  Rooted    Rootless
                     1-bit/pixel   Monochrm/ Monochrm/ Color/    Color/
                    (monochrome)   Rooted    Rootless  Rooted    Rootless

Color                Any           Color/    Color/    Monochrm/ Monochrm/
(Rootless)                         Rootless  Rooted    Rootless  Rooted

Color                Any           Color/    Color/    Monochrm/ Monochrm/
(Rooted)                           Rooted    Rootless  Rooted    Rootless

Monochrome           Any           Monochrm/ Monochrm/ Color/    Color/
(Rootless)                         Rootless  Rooted    Rootless  Rooted

Monochrome           Any           Monochrm/ Monochrm/ Color/    Color/
(Rooted)                           Rooted    Rootless  Rooted    Rootless

   • Click the Black and White button, and screen zero (the default screen)
     will support X client applications that only require 1 bit per pixel.

   • Click the Color button, and screen zero (the default screen) will
     support X client applications requiring 8-bit color.

   • The Screen Zero option is preset to Match Best Monitor. With this
     selection, MacX configures the default screen in either of two ways:
      - as an 8-bit color screen if your monitor is set for greater than 1
        bit per pixel
      - as a 1-bit monochrome screen if your monitor is set for 1 bit per
        pixel (black and white)

   • The screen zero option is preset to Rootless. With this selection, X
     clients that connect to the default screen are displayed in rootless
     mode; that is, they are managed by the Macintosh Window Manager
     alongside other Macintosh application windows.

   • Click the Rooted button, and X clients that connect to the default
     screen are displayed in rooted mode; that is, they are drawn on an X
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     root window and must be managed by a foreign (remote) window manager.

   • The Disable Non-zero Screens option is preset to "enabled." With this
     selection, all screens other than the default screen (screen zero) are
     ignored by MacX. As a result, client applications that are designed to
     connect only with screen zero are displayed correctly on the MacX
     server because multiple screens are no longer available. To turn off
     this option, click the checkbox to remove the "X" from the box.

4) Click the OK button to confirm your preferences.
   An alert box appears to report that your preferences will not be enabled
   until the MacX file, or document, is reopened.

5) Click the OK button to dismiss the alert box.

6) Save, close, then reopen the MacX document to enable your new display
   preferences.

For more information about rooted and rootless windows, see Chapter 1 of
your MacX User's Guide.

Support for Backing Store and Save Under to Preserve Client Windows
-------------------------------------------------------------------
MacX now provides Backing Store and Save Under features as defined by the X
Window System standard.

By default, Backing Store and Save Under support are given to those client
applications that require the MacX server to preserve window contents.
Typically, these X clients create complex graphic images that can take a
substantial amount of time to refresh. By taking advantage of Backing Store
and Save Under, X client applications can greatly reduce the time they need
to refresh their windows.

These new capabilities, however, may incur an additional memory cost to
your MacX application program because the MacX server must set aside
additional memory to preserve portions of client windows.

• Backing Store and Save Under may consume additional memory.  In the
  course of providing Backing Store and Save Under to X client
  applications, MacX may use additional memory. As a result, you may want
  to increase the "application memory size" of MacX. For more information,
  see "Can't Use a MacX Feature," in Chapter 6 of your MacX User's Guide.

Backing Store and Save Under features are set by default to provide you
with the level of support required by most X client applications.
Experienced users of the X Window System, however, may want to adjust this
level. For example, you can disable Backing Store entirely or force it on
every window of every X client. In addition, you can disable Save Under
entirely.

Follow these steps to change the level of Backing Store capability.

1) Open the MacX application program by double-clicking its icon.
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2) Choose the Display Preferences command from the Edit menu.

3) Click the Backing Store option that corresponds to the level of feature
   support needed.

   • Click the Off button to disable the Backing Store feature entirely.
     With the feature in this state, client applications must redraw their
     windows each time they are exposed. You save computer memory, but you
     may have to wait for some client windows to redraw themselves when
     Backing Store is turned off. The amount of computation time needed to
     redraw the client window depends on the client application itself, the
     network bandwidth, and the speed of your computer.

   • The Backing Store feature is preset to Requesting Clients. This
     selection enables the Backing Store feature only for the windows of
     client applications that request it. Clients that do not request
     Backing Store may redraw their windows more slowly than those with the
     feature enabled.

   • Click the All Windows button to provide Backing Store capability for
     all client application windows, regardless of whether or not they
     request it. With the feature in this state, you typically use
     additional computer memory but get the benefit of not having to wait
     for client windows to redraw themselves each time they are exposed.
     Because many clients (particularly those that primarily draw text)
     perform worse with Backing Store enabled, this setting should be used
     with caution.

4) Click the Save Under option that corresponds to the level of feature
   support needed.

   • Click the Off button to disable the Save Under feature. With the
     feature in this state, client applications must redraw their windows
     each time they are exposed. You save computer memory when Save Under
     is turned off, but you may have to wait for some client windows to
     redraw themselves.

   • The Save Under feature is preset to Requesting Clients. This selection
     enables the Save Under feature only for the windows of client
     applications that request it. When a window requesting Save Under is
     displayed on your monitor, the contents of windows behind it are saved
     (even if they didn't request Backing Store); when the window is
     dismissed, the saved contents are restored. Save Under is used mainly
     for transient windows such as menus and dialog boxes.

5) Click the OK button to confirm your preferences.
   An alert box appears to report that your preferences will not be enabled
   until the MacX file, or document, is reopened.

6) Click the OK button to dismiss the alert box.

7) Save, close, then reopen the MacX document to enable your new display
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   preferences.

Greater Client Compatibility with colormaps
-------------------------------------------
MacX 1.2 makes all 256 entries of each screen's default colormap available
for use by X client applications. A default "standard" colormap is no
longer installed automatically by MacX. This change provides support for
those X client applications that require many free colormap entries in the
screen's default colormap.

Earlier versions of MacX installed a standard colormap as the screen
default colormap, leaving only 128 empty colormap entries available for
client allocation. This caused problems with clients requiring that more
than 128 colormap entries be available in the default colormap.

If your particular X application expects a standard colormap to be present
in the screen default colormap, follow these steps to load the standard
colormap:

1) Open the MacX application program by double-clicking its icon.

2) Choose the Misc. Preferences command from the Edit menu.

3) Click the Load Standard Colormap at Startup checkbox.

4) Click the OK button to confirm your preferences.
   An alert box appears to report that your preferences will not be enabled
   until the MacX file, or document, is reopened.

5) Click the OK button to dismiss the alert box.

6) Save, close, then reopen the MacX document to load the standard
   colormap.

• Are you having trouble displaying a color X client on your MacX server
  alongside other color clients?  Try displaying the troublesome client
  application on your MacX server by itself. Your other X clients may have
  filled up the colormap, and the troublesome application, finding the
  colormap already full and not requesting MacX to create a new one, fails
  to run. By running only the troublesome X client application, you allow
  it to take advantage of all the colormap entries it needs since no other
  applications are competing for colormap entries.

Faster Display of Client Applications, with Smoother Animation Turned Off
-------------------------------------------------------------------------
Smoother (but Slightly Slower) Animation is no longer enabled by default,
with the result that client applications may be displayed more quickly on
your MacX screen.

The Smoother Animation option regulates how often MacX responds to client
graphics requests. With this option turned off, client graphics requests
are batched for approximately one-sixth of a second before executing to
prevent constant screen refreshing—a time-consuming process.
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With Smoother Animation turned on, client graphics requests are rendered
immediately, meaning that client applications may be displayed more slowly
on your monitor than with the feature turned off.

Depending on your needs, you can enable Smoother Animation anytime. Follow
these steps:

1) Open the MacX application program by double-clicking its icon.

2) Choose the Misc. Preferences command from the Edit menu.

3) Click the Smoother (but Slightly Slower) Animation checkbox.

4) Click the OK button to enable your new preference and to dismiss the
   preferences window.

For more information about animation preferences, see the section
"Animation and Mouse-Movement Preferences" in Appendix A of the MacX User's
Guide.

Easy Client Access to MacX, with Host Access Alert Boxes Turned Off
-------------------------------------------------------------------
Host access alert boxes are no longer enabled by default, allowing
unrestricted access by client applications to MacX. As a security feature,
the following alert box, if enabled, appears automatically when clients
attempt to connect to MacX. The alert box requests your permission to
accept connections from the client.

This alert box may appear several times in the course of establishing a
connection. With the alert box suppressed, you no longer have to respond to
it before clients can connect to MacX. However, this also means that you no
longer have control over client connections.

Depending on your needs, you can enable the host access alert box at any
time. Follow these steps:

1) Open the MacX application program by double-clicking its icon.

2) Choose the Access Control command from the Remote menu.

New Window Commands for Easier Window Control
---------------------------------------------
Three new commands have been added to the Window menu to give you greater
convenience when controlling windows.

Circulate Up (Cmd-U)  This command causes the window farthest back in the
collection of MacX windows to be brought to the front of the stack. This is
handy for switching between windows easily without removing your hands from
the keyboard to use the mouse.

Circulate Down (Cmd-D)  This command causes the front most window in the
collection of MacX windows to be sent to the back of the stack. This is
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handy for switching between windows easily without removing your hands from
the keyboard to use the mouse.

Maximize Height/Restore Height (Cmd-M)  This command, which is only enabled
when the front most window is a rootless X client window, makes the
front most window taller by extending its bottom edge to the bottom of the
screen. If the front most window has already been extended in this way, the
command restores the window's previous height.

Window Dimensions Reported During Resizing
------------------------------------------
While rootless X windows are being resized, the size of the window in
client-specified units (normally, pixels for graphics or characters for
text-oriented clients such as terminal emulators) is displayed in the menu
bar.
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